
HP Anywhere IDE
Windows

软件版本： 10.10

开发人员指南 (Eclipse)

文档发布日期： 2013年 12月

软件发布日期： 2013年 12月



法律声明

担保

HP产品和服务的唯一担保已在此类产品和服务随附的明示担保声明中提出。此处的任

何内容均不构成额外担保。HP不会为此处出现的技术或编辑错误或遗漏承担任何责

任。

此处所含信息如有更改，恕不另行通知。

受限权利声明

机密计算机软件。必须拥有 HP授予的有效许可证，方可拥有、使用或复制本软件。按

照 FAR 12.211和 12.212，并根据供应商的标准商业许可的规定，商业计算机软件、计

算机软件文档与商品技术数据授权给美国政府使用。

版权声明

© Copyright 2012 - 2013 Hewlett-Packard Development Company, L.P.

商标声明

Adobe®是 Adobe Systems Incorporated的商标。

Microsoft®和 Windows®是 Microsoft Corporation在美国的注册商标。

Oracle和 Java是 Oracle及其附属机构的注册商标。

HP Anywhere IDE (10.10) 第 2页 (共 49页 )



文档更新
此文档的标题页包含以下标识信息：

l 软件版本号，用于指示软件版本。

l 文档发布日期，该日期将在每次更新文档时更改。

l 软件发布日期，用于指示该版本软件的发布日期。

要检查是否有最新的更新，或者验证是否正在使用最新版本的文档，请访问：

http://h20230.www2.hp.com/selfsolve/manuals

需要注册 HP Passport才能登录此站点。要注册 HP Passport ID，请访问：

http://h20229.www2.hp.com/passport-registration.html

或单击 “HP Passport”登录页面上的 “New users - please register”链接。

此外，如果订阅了相应的产品支持服务，则还会收到更新的版本或新版本。有关详细

信息，请与您的 HP销售代表联系。
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支持
请访问 HP软件联机支持网站：

http://www.hp.com/go/hpsoftwaresupport

此网站提供了联系信息，以及有关 HP软件提供的产品、服务和支持的详细信息。

HP软件联机支持提供客户自助解决功能。通过该联机支持，可快速高效地访问用于管

理业务的各种交互式技术支持工具。作为尊贵的支持客户，您可以通过该支持网站获

得下列支持：

l 搜索感兴趣的知识文档

l 提交并跟踪支持案例和改进请求

l 下载软件修补程序

l 管理支持合同

l 查找 HP支持联系人

l 查看有关可用服务的信息

l 参与其他软件客户的讨论

l 研究和注册软件培训

大多数提供支持的区域都要求您注册为 HP Passport用户再登录，很多区域还要求用户

提供支持合同。要注册 HP Passport ID，请访问：

http://h20229.www2.hp.com/passport-registration.html

要查找有关访问级别的详细信息，请访问：

http://h20230.www2.hp.com/new_access_levels.jsp
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为何使用 HP Anywhere IDE (Eclipse)创建
应用程序

HP Anywhere提供基于 Eclipse的 IDE，支持您创建、构建、运行和调试您自己的应用程

序。

此 IDE提供完整的开发环境，涵盖应用程序的整个生命周期以及支持您创建、调试和

维护应用程序项目。HP Anywhere IDE包括：

l 用于创建应用程序项目的向导

l 内置模拟器，可用于在任何窗体因子 (台式电脑、平板电脑或智能手机 )或屏幕分辨

率中运行和调试应用程序

l 用于为您发布应用程序的部署功能，包括适用于本地部署应用程序的热部署功能，

以及便于应用程序始终可供生产的自动缩小功能。

l 完整、预配置、无数据库并且可进行调试的 HP Anywhere服务器，已针对开发环境

对其进行自定义和优化。
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如何使用 HP Anywhere IDE构建和运行应
用程序 -端到端演练

以下步骤描述了如何使用 HP Anywhere IDE构建和运行应用程序。

1. 确保已在计算机上安装 HP Anywhere IDE。

2. 使用 HP Anywhere应用程序项目向导创建应用程序项目的包和文件。此过程将为您

提供可随时运行的应用程序，包括所有必需的文件、类和方法。您可以从任何可

用的模板中进行选择，以开始创建。有关详细信息，请参见如何在  HP Anywhere
IDE中创建应用程序项目 (第 9页 )、附录 1：应用程序项目文件夹结构 (第 38页 )和
附录 2：模板描述 (第 41页 )。

3. 添加代码。

4. 定义应用程序配置设置。有关详细信息，请参见如何为我的应用程序定义配置 (第
16页 )。

5. 通过在内置的 HP Anywhere本地服务器或远程服务器上运行应用程序来运行和调试

此应用程序。有关详细信息，请参见如何在本地服务器上运行应用程序 (第 18页 )
和如何调试应用程序代码 (第 31页 )。

6. 准备好应用程序后，可将此应用程序内容包 .zip文件提供给 HP Anywhere管理员，

以便他或她能够在 HP Anywhere服务器上部署它并在目录中启用它。此 .zip文件具

有以下命名约定：<应用程序名称>-cp.zip，位于 <应用程序项目>\target文件夹中。
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如何在  HP Anywhere IDE中创建应用程序
项目

您可以使用 HP Anywhere应用程序项目向导创建新的包含应用程序文件和类的 HP
Anywhere IDE 项目。

使用 HP Anywhere IDE创建应用程序时，会在 <应用程序项目>\target文件夹中生成 .zip
文件的应用程序内容包。

此 .zip文件具有以下命名约定：<应用程序名称>-cp.zip。准备好应用程序后，需要将此

文件提供给 HP Anywhere管理员，以便他或她能够将此应用程序部署在 HP Anywhere服
务器上并在目录中启用它。

备注 :如果通过代理连接到 Internet，则需在首次创建应用程序时配置 Maven代理。

有关详细信息，请参见如何设置 Maven代理 (第 45页 )。

关于 IntelliJ IDEA 应用程序的说明：如果要继续开发初始使用 IntelliJ IDEA的 HP
Anywhere IDE创建的应用程序，请在将此应用程序项目导入到 HP Anywhere IDE 
(Eclipse)后运行以下命令。 (您只需执行一次此步骤。 )：

mvn eclipse:eclipse

要在 HP Anywhere IDE 中创建 HP Anywhere应用程序项目，请执行以下操作：

1. 选择 File > New > HP Anywhere App Project。此时会打开 HP Anywhere App Project向
导。

HP Anywhere IDE (10.10) 第 9页 (共 49页 )

开发人员指南 (Eclipse)
如何在  HP Anywhere IDE中创建应用程序项目



HP Anywhere IDE (10.10)第 10页 (共 49页 )

开发人员指南 (Eclipse)
如何在  HP Anywhere IDE中创建应用程序项目



2. 在 “Project Template”区域的 Type下拉列表中，选择模板类型。每个模板会生成一个

启动程序项目，您可以向其添加自己的代码。以下几种类型可供选择：

n Blank project。HP Anywhere启动程序项目，其项目文件夹结构中不包含应用程

序内容。

n Hello World projects。 HP Anywhere启动程序项目，使用指定框架 (例如本

机、Enyo、JQM、Sencha或 AngularJS)生成应用程序。这些项目面向平板电脑和

智能手机使用。

n My Report projects。 HP Anywhere启动程序项目，用于生成可显示报告列表的应

用程序。这些项目使用指定框架 (例如本机、Enyo、JQM、Sencha或 AngularJS)。
这些项目面向平板电脑和智能手机使用。

Description框提供选定模板的详细信息。

有关每个这些模板的详细描述，请参见附录 2：模板描述 (第 41页 )。

3. 在 “Form Factor”区域中，选择一个或多个窗体因子。以下窗体因子可用：

n Desktop

n Tablet

n Smartphone

注意：创建项目之后，可手动添加在创建项目时未选择的窗体因子。有关详

细信息，请参见如何在我的应用程序项目中添加或删除窗体因子 (第 14页 )。

4. 如果计划应用程序在无 Internet连接的情况下工作，请在 “App Preferences”区域中选

中 Allow an app to run in offline mode复选框。

备注 :选中此复选框的操作本身不会启用脱机支持。还必须添加代码以支持脱

机模式。有关详细信息，请参见 Developer Zone中的示例应用程序手册。

5. 在 “Project Details”区域中，使用标准 Maven命名约定定义以下内容：

n App Name。应用程序的名称，例如 HelloWorld。 (只能使用字母数字字符。不允许

使用特殊字符和空格。 )

n Group ID。唯一反向域名，例如 com.mycompany.mygroupname。组 ID 用于生成的

POM.XML 项目文件。

n Source package。有效的 Java包名称，例如 com.my.mypackage。包名称代表工作

区中生成的文件夹结构。

n App version。应用程序的版本字符串，例如 1.0.0。
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n App icon。用于表示应用程序的 PNG文件。此图标将显示在 HP Anywhere“我的应

用程序 ”页面的此应用程序中。

6. 单击 Finish。HP Anywhere将生成此应用程序项目。创建项目时，可在揅onsole(首
次创建项目时，可能需要一些时间。 )创建项目之后，您可以：

n 查看项目文件夹结构。有关详细信息，请参见附录 1：应用程序项目文件夹结构

(第 38页 )

n 将代码添加到应用程序项目。

n 运行应用程序。有关详细信息，请参见如何在本地服务器上运行应用程序 (第 18
页 )。
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如何将第三方库添加到我的应用程序
如果要将第三方依赖关系添加到 pom.xml文件，还必须将其作为 Eclipse依赖关系添加

到 HP Anywhere项目。此操作将允许在 IDE中执行代码编译。

1. 打开命令行 (CLI)。

2. 将目录更改为应用程序根目录。

3. 运行以下命令：%btoa_home%\apache-maven-3.0.4\bin\mvn eclipse:eclipse

4. 在项目树中，右键单击此应用程序节点并选择刷新，可在 HP Anywhere IDE中刷新

此应用程序项目。

支持的第三方库

您的应用程序可以使用以下第三方库：

l Spring(版本 3.0.5)

l Jackson(版本 1.5.5)

l Jersey(版本 1.5)

l JSR 311-api(版本 1.1.1)

l ApacheWink Client(版本 1.1.1)

l Hibernate Validator(版本 4.2.0)

l CGLIB(版本 2.2)

l SLF4J LOG4J(版本 12 1.5.11)
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如何在我的应用程序项目中添加或删除窗
体因子

在创建应用程序项目时，您可以指定要运行应用程序的窗体因子 (台式电脑 /平板电脑 /
智能手机 )。

如果在创建项目时没有选择所有窗体因子，您可以稍后进行添加，方法是将所需窗体

因子的文件夹添加到应用程序包。同样，您也可以通过删除相关项目文件夹，将窗体

因子从应用程序中删除。

要为应用程序添加窗体因子，请执行以下操作：

1. 在 HP Anywhere IDE Package Explorer中，展开主应用程序文件夹。

2. 在以下每个位置中复制 /粘贴现有窗体因子 (台式电脑、平板电脑或智能手机 )的文件

夹：

l src > webapp > app

l src > webapp > css

l src > webapp > images

3. 将每个新文件夹重命名为所需的窗体因子类型 (台式电脑、平板电脑或智能手机 )。

4. 将客户端代码添加到新的窗体因子文件夹。

5. 在 src/resources > descriptor.xml中，通过复制以下部分并使用 <新窗体因子类型>
替换 <现有窗体因子类型>，可为每个窗体因子创建一个部分。例如，复制以下部

分并使用 SMARTPHONE替换 DESKTOP。
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要删除窗体因子，请执行以下操作：

在 HP Anywhere IDE Package Explorer中：

1. 展开主应用程序文件夹。

2. 从 src/resources > descriptor.xml中删除相关部分。例如，要删除台式电脑窗体因

子，请删除以下部分：

3. (可选 )在以下每个位置中，将要删除的每个窗体因子 (台式电脑、平板电脑或智能手

机 )的文件夹删除：

l src > webapp > app

l src > webapp > css

l src > webapp > images
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如何为我的应用程序定义配置
在创建应用程序之后，您可配置其设置，这些设置位于 src/resources文件夹中。

用户设置

您可以为应用程序用户定义这些设置。

要修改用户设置，请执行以下操作：

1. 在 Package Explorer中，导航到： /<应用程序主节点>/src/resources/<应用程序名
称>-user-settings.xml并双击此文件。

2. 在 应用程序名称>-user-settings.xml选项卡中，选择 Design选项卡。

3. 右键单击 context，然后选择 Add Child > setting。

4. 展开刚添加的设置节点，然后为以下对象输入值：
a. name。此设置的 ID。

b. namekey。用于本地化的设置。

c. integer。默认设置类型。您可以通过右键单击并选择 Replace With > <值类型>
来修改此类型。

可能的值：

boolean
枚举

float
password
string
xml

管理员设置

您可以为应用程序管理员定义这些设置。

要修改管理员设置，请执行以下操作：

1. 在 Package Explorer中，导航到： /<应用程序主节点>/src/resources/<应用程序名
称>-admin-settings.xml并双击此文件。

2. 在 应用程序名称>-admin-settings.xml选项卡中，选择 Design选项卡。

3. 右键单击 context，然后选择 Add Child > setting。

4. 展开刚添加的设置节点，然后为以下对象输入值：
a. name。此设置的 ID。

b. settingType。确保已选择 global。
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c. displayInUI。指定应用程序是否在 HP Anywhere Administrator Console中可见。

可能的值：

true
false

d. sectionKey。显示在 Administrator Console的 “设置 ”选项卡中的组区域的名称 (针对

在 “List of Categories”列中已选择的应用程序 )。

e. integer。默认设置类型。您可以通过右键单击并选择 Replace With > <值类型>
来修改此类型。

可能的值：

boolean
枚举

float
password
string
xml

数据源设置

您可以定义用于应用程序与后端服务器通信的设置。

1. 在 Package Explorer中，导航到： /<应用程序主节点>/src/resources/<应用程序名
称>-ds-provider.xml并双击此文件。

2. 在 应用程序名称>-admin-settings.xml选项卡中，选择 Source选项卡。

3. 根据需要修改此配置。
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如何运行和查看应用程序
您可以在本地或远程服务器上以调试模式或运行模式运行应用程序。HP Anywhere IDE 
提供内置本地服务器，支持您利用热部署功能。

在运行应用程序时，HP Anywhere会执行以下操作：

1. 如果 HP Anywhere服务器尚未启动并运行，则启动此服务器。

2. 在指定服务器上部署应用程序 (如果需要 )。

3. 创建两个版本的应用程序，一个版本用于开发，另一个版本经过缩小处理并准备

用于生产。可以在输出中切换两个版本。

4. 在 Chrome浏览器中打开 HP Anywhere模拟器。

首次运行应用程序项目时，HP Anywhere IDE 会编译项目文件、压缩这些文件并在 HP
Anywhere服务器上部署它们。

之后，在本地服务器上修改项目文件并运行应用程序时，HP Anywhere会提供 Java代
码的热部署，因此您可以实时修改应用程序，而无需重新启动服务器。

您可以在内置模拟器或您自己的移动设备上查看和调试应用程序 (如果设备处于同一个

LAN中并且已在该设备上安装了 HP Anywhere客户端 )。有关详细信息，请参见如何在

远程服务器上运行应用程序 (第 21页 )。

备注 :有关运行使用 HP Anywhere早期版本创建的旧应用程序的详细信息，请参见

如何运行使用 HP Anywhere IDE早期版本创建的应用程序 (第 47页 )。

提示 :要清理数据库并删除所有已部署的应用程序及其配置文件，请单击 Remove

All Deployed Apps 。

(您可能需要从 Eclipse(在 “Servers”选项卡中 )手动删除链接的项目。 )

如何在本地服务器上运行应用程序

您可以在内置的本地服务器上运行应用程序。这支持您利用热部署功能。

要在本地服务器上以运行模式运行应用程序，请执行以下操作：

1. 针对 Sencha用户的先决条件 (需针对每台计算机执行一次 )：

a. 确保计算机上安装了Sencha version 2.0.0 Beta 3 forWindows。

b. 从 http://phantomjs.org/下载 phantomjs-1.9.1-windows.zip。

c. 从此 .zip文件中提取 phantomjs.exe并将其复制到剪贴板。
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d. 在 Sencha \bin文件夹中粘贴 (覆盖 )phantomjs.exe，例如：C:\Program Files (x86)
\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe

2. 执行以下操作之一：

n 在项目资源管理器中，右键单击 HP Anywhere项目文件夹并选择 Run HP
Anywhere App。

n 单击 。

此时会打开 “RunOn Server”对话框。

3. 选择 Local HP Anywhere Server at localhost，然后单击 Finish。服务器将使用默认

的窗体因子和分辨率启动和运行应用程序。应用程序运行时，可在揅onsole
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4. 运行完成时，此应用程序将在 Chrome浏览器中打开，如下例所示。如果项目包含

的代码支持其他窗体因子和分辨率，则您可以在模拟窗体因子上方的下拉箭头中

选择它们。此外，也可以双击模拟窗体因子查看更多详细信息。

有关如何在应用程序的开发版本和缩小版本之间切换的详细信息，请参见如何缩小

应用程序 (第 33页 )。
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如何在远程服务器上运行应用程序

您可以在远程服务器上运行应用程序。有关常规详细信息，请参见如何运行和查看应

用程序 (第 18页 )。

要在远程服务器上以运行模式运行应用程序，请执行以下操作：

1. 针对 Sencha用户的先决条件 (需针对每台计算机执行一次 )：

a. 确保计算机上安装了Sencha version 2.0.0 Beta 3 forWindows。

b. 从 http://phantomjs.org/下载 phantomjs-1.9.1-windows.zip。

c. 从此 .zip文件中提取 phantomjs.exe并将其复制到剪贴板。

d. 在 Sencha \bin文件夹中粘贴 (覆盖 )phantomjs.exe，例如：C:\Program Files (x86)
\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe

2. 执行以下操作之一：
n 在项目资源管理器中，右键单击 HP Anywhere项目文件夹并选择 Run HP

Anywhere App。

n 单击 。

n 在包资源管理器或项目资源管理器中，右键单击 HP Anywhere项目文件夹并选择

Run As > Run On Server。
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此时会打开 “RunOn Server”对话框。
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3. 选择 Manually define a new server。此对话框允许您指定其他服务器。

n 选择 Remote HP Anywhere Server。

n 在 Server's host name框中，指定远程服务器的名称或 IP 地址。

n (可选 )在 Server name框中，修改服务器名称。

n (可选 )如果要始终仅在此服务器上运行应用程序，请选中 Always use this server
when running this project复选框。
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4. 单击 Next。此时会打开 JRE首选项页。

将 HP Server home路径设置为 <安装文件夹>，例如：

C:/HP/HPAnywhere
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5. 单击 Next。此时将打开登录详细信息页。根据需要修改默认值。
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6. 单击 Next。此时将打开 “Add and Remove”页。

(可选 )可以根据需要添加或删除要在此服务器上运行的项目。

7. 单击 Finish。此服务器将使用默认的窗体因子和分辨率在指定的远程服务器上启动

并运行应用程序。应用程序运行时，可在揅onsole

备注 :如果 Chrome生成与配置文件相关的错误消息，请关闭此消息并继续进行

下一步操作。
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8. 运行完成时，此应用程序将在 Chrome浏览器中打开，如下例所示。如果项目包含

的代码支持其他窗体因子和分辨率，则您可以在模拟窗体因子上方的下拉箭头中

选择它们。此外，也可以双击模拟窗体因子查看更多详细信息。

备注 :在远程服务器上运行某个应用程序之后，可能需要在目录中手动启用此

应用程序。

有关如何在应用程序的开发版本和缩小版本之间切换的详细信息，请参见如何缩

小应用程序 (第 33页 )。
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如何在设备上运行应用程序

您可以从任何受支持的智能手机、平板电脑或台式电脑 /笔记本电脑运行应用程序。

要在设备上运行应用程序，请执行以下操作：

1. 对于移动设备，请从 Google Play或 Apple App Store安装 HP Anywhere客户端。

2. 通过与 HP Anywhere服务器相同的 LAN将移动设备或台式电脑 /笔记本电脑连接到

Internet。

3. 从设备登录到已安装应用程序的 HP Anywhere服务器。
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如何在  HP Anywhere模拟器上查看应用程序

您可以使用 HP Anywhere模拟器在任何窗体因子中查看应用程序。

备注 :在 HP Anywhere模拟器中打开应用程序项目之前，必须至少运行一次此项

目，并且服务器必须正在运行。

要在 HP Anywhere模拟器中查看此应用程序项目，请执行以下操作：

1. 执行以下操作之一：
n 在项目资源管理器中，右键单击此项目并选择 View HP Anywhere App

Simulator。

n 单击 。
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此应用程序将在上一次运行此项目的服务器上的 Chrome浏览器中打开。

备注 :窗口顶部的 HP Anywhere模拟器栏将超时并自动隐藏，以便您使用整个

界面。要恢复此栏，请单击此栏下方的蓝线。

2. 在 HP Anywhere模拟器栏中，单击所需窗体因子旁边的箭头并选择所需的屏幕分辨

率。 (将在新的选项卡或窗口中打开桌面。 )

备注 : HP Anywhere模拟器栏中只会启用在创建项目时指定的窗体因子。

有关如何在应用程序的开发版本和缩小版本之间切换的详细信息，请参见如何缩

小应用程序 (第 33页 )。
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如何调试应用程序代码
您可以在调试模式中运行应用程序。

要调试应用程序，请执行以下操作：

1. 在 Eclipse IDE中，右键单击应用程序项目文件夹并选择 Debug As > Debug On
Server。此时会打开 “DebugOn Server”对话框。
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2. 选择 Local HP Anywhere Server at localhost，然后单击 Finish。服务器将启动并在

本地服务器上运行应用程序。应用程序运行之后，您可以在揅onsole

3. 运行完成后，会在 Chrome浏览器中打开此应用程序。页面底部显示开发工具。

4. 调试代码：

a. 采用在 Eclipse中调试代码的方式调试 Java代码 (使用断点等 )。例如，请查

看：http://www.eclipse.org/resources/resource.php?id=503

b. 在 Chrome浏览器中调试 JavaScript客户端代码。例如，请查

看：https://developers.google.com/chrome-developer-tools/docs/javascript-debugging
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如何缩小应用程序
缩小是从源代码中删除所有不必要的字符 (例如空格、换行符、注释和块分隔符 )而不改

变代码功能的过程。

HP Anywhere应用程序项目文件在进入生产阶段之前必须缩小。为了简化此流程，HP
Anywhere IDE提供了预置的缩小机制，用于为您自动缩小应用程序项目。

缩小流程依赖于框架。HP Anywhere针对使用本机、Enyo和 jQuery Mobile (JQM)框架创

建的应用程序提供自动缩小支持。 (对于 Sencha，请参见下方说明。 )此外，还可以通过

在项目的根文件夹中编辑 minify.bat文件，添加您自己的缩小流程。

当 HP Anywhere IDE构建应用程序项目时，会创建两个版本，一个版本用于开发，另一

个版本经过缩小处理并准备用于生产。您可以随时在两个版本之间切换，方法是在

URL中修改 appdev标志，如下所述。

要在应用程序的开发版本和缩小版本之间切换，请执行以下操作：

在 URL中设置 appdev的值，如下：

l appdev=true，为开发模式

l appdev=false，则为缩小模式

示例 URL：

http://localhost:8080/simulator/simulator.jsp?user=myusername&password=mypassword&appde
v=true&miniApp=MR&serverHost=localhost:8080

提示 :此外，还可以删除 &appdev=true部分，显示缩小版本。

针对 Sencha开发人员的说明：

1. 在缩小或运行应用程序之前，必须替换 Sencha /bin文件夹中的 phantomjs.exe
文件。 (此步骤需针对每台计算机执行一次 )：

a. 确保计算机上安装了Sencha version 2.0.0 Beta 3 for Windows。

b. 从 http://phantomjs.org/下载 phantomjs-1.9.1-windows.zip。

c. 从此 .zip文件中提取 phantomjs.exe并将其复制到剪贴板。

d. 在 Sencha \bin文件夹中粘贴 (覆盖 )phantomjs.exe，例如：C:\Program Files
(x86)\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe

2. 在构建基于 Sencha的应用程序项目时，必须通过命令行界面 (CLI)运行以下命

令来手动运行缩小流程：
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cd <基于 Sencha的项目>/src/webapp

minify sencha
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当应用程序更改时如何启用热部署和同步
在本地服务器上将某个应用程序至少运行一次后，便会自动启用热部署。这意味着每

次保存项目时，都会将静态 JavaScript和配置文件自动与本地 HP Anywhere服务器上的

文件同步。

如果导入使用 HP Anywhere IDE创建的应用程序项目，则可以指示 HP Anywhere IDE 将
对应用程序文件所做的任何变更与本地服务器上的已部署应用程序同步。

本节描述如何：

l 要在静态 (JavaScript)文件 (/src/webapp/)上启用 /禁用自动热部署，请执行以下操作：

(第 35页 )。应用于文件，例如 CSS或图像文件。

l 要对 Java代码执行按需热部署，请执行以下操作： (第 36页 ) .

l 要启用 /禁用应用程序配置文件 (/src/resources)同步，请执行以下操作： (第 37页 )。
应用于 <应用程序名称>-admin-settings.xml、<应用程序名称>-ds-provider.xml、<应用

程序名称>-user-settings.xml。默认情况下，自动同步这些文件。

要在静态 (JavaScript)文件 (/src/webapp/)上启用 /禁用自动热部署，请执行以下操作：

备注 :默认情况下，启用自动热部署。

1. 先决条件：

a. 构建应用程序。有关详细信息，请参见如何在  HP Anywhere IDE中创建应用程序

项目 (第 9页 )。

b. 在本地服务器上将应用程序至少运行一次。有关详细信息，请参见如何在本地

服务器上运行应用程序 (第 18页 )。

c. 确保本地服务器已启动并正在运行。

2. 在项目树中：

a. 右键单击应用程序节点并选择 Properties。

b. 在 “Properties”对话框的左侧窗格中，选择 File synchronization。
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c. 在 “File synchronization”窗格中，选中 Enable FileSync builder for project复选框并

单击确定，启用热部署。

清除 Enable FileSync builder for project复选框，禁用自动热部署。

从现在开始，无论何时保存应用程序项目，所做的变更均会保存到本地服务器

中。

要对 Java代码执行按需热部署，请执行以下操作：

1. 先决条件：

a. 构建应用程序。有关详细信息，请参见如何在  HP Anywhere IDE中创建应用程序

项目 (第 9页 )。

b. 在本地服务器上将应用程序至少运行一次。有关详细信息，请参见如何在本地

服务器上运行应用程序 (第 18页 )。

c. 确保本地服务器已启动并正在运行。

2. 在项目树中，右键单击应用程序节点并选择 Reload HP Anywhere App。服务器将

重新加载包含已修改的 Java代码的应用程序。
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备注 :如果在尝试重新加载应用程序时持续收到通知，指示 HP Anywhere服务器未

启动，则需配置 eclipse.ini文件，如下：

1. 关闭 HP Anywhere IDE。

2. 在文本编辑器中打开 <HP Anywhere安装文件夹>\eclipse\eclipse.ini文件。

3. 将以下行添加到文件的末尾：

-Dhttp.nonProxyHosts=localhost|127.0.0.1

4. 重新启动 HP Anywhere IDE。

要启用 /禁用应用程序配置文件 (/src/resources)同步，请执行以下操作：

(应用于管理员设置、数据源提供程序和用户设置的 XML 文件 )

1. 在项目树中：

a. 右键单击应用程序节点并选择 Properties。

b. 在 “Properties”对话框的左侧窗格中，选择：

o Configure > 添加HP Anywhere Builder，启用应用程序配置文件同步。 (默认情

况下，针对所有新的 HP Anywhere应用程序项目选中这些选项 )

o Configure > RemoveHP Anywhere Builder，禁用应用程序配置文件自动同步。

2. (可选 )更改代码后，打开 HP Anywhere Console可以查看同步消息。例如：
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附录 1：应用程序项目文件夹结构
随 HP Anywhere IDE 提供的每个模板均使用特定框架 (例如 Sencha、Enyo、JQM或本机

框架 )生成应用程序。如果您熟悉这些框架，就会发现与可能已创建的其他项目的多个

相似之处。

此部分将概述作为 HP Anywhere IDE 应用程序项目的一部分而生成的唯一文件和文件

夹。

默认情况下，每个应用程序项目具有以下包结构：

每个项目包括以下文件夹：

项目名称 在 HP Anywhere应用程序项目向导中定义的应用程序项目的不可

修改名称。
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src/java 应用程序使用的 Java代码。每个模板均具有其自己的 REST服

务。特定于报告的模板均使用相同服务来检索数据。Java具有两

大类：一类是 Java bean (ReportBean.java)，可检索实体；另一类是

Java服务 (ReportService.java)，可检索报告数据。

src/resources 服务器端配置文件 (例如设置、数据源和本地化文件 )。

l10n。本地化文件夹，其中包括应用程序每种显示语言的

*.properties文件。

log。日志文件的文件夹包括 log4j.properties和
logging.properties。

descriptor.xml。指定应用程序支持的所有窗体因子 (台式电脑、平

板电脑和 /或智能手机 )。 (您可将实际资源文件存储在

src\webapp\<app/css/images>下，如下所述。 )
有关在项目中添加或删除窗体因子的详细信息，请参见如何在我

的应用程序项目中添加或删除窗体因子 (第 14页 )。

<应用程序名称>-admin-settings.xml。指定适用于应用程序管理员

的设置。有关详细信息，请参见如何为我的应用程序定义配置 (第
16页 )中的管理员设置部分。

<应用程序名称>-ds-provider.xml。指定用于应用程序与后端服务

器通信的数据源设置。有关详细信息，请参见如何为我的应用程

序定义配置 (第 16页 )中的数据源设置部分。

<应用程序名称>-user-settings.xml。指定适用于应用程序用户的设

置。有关详细信息，请参见如何为我的应用程序定义配置 (第 16
页 )中的用户设置部分。

Referenced
Libraries

可用于应用程序的第三方库 (项目依赖关系 )。

JRE System
Library

可用于应用程序的 JRE 库。

src 按窗体因子划分到文件夹中的 JavaScript客户端代码。common文

件夹包含所有定义的窗体因子所使用的 JavaScript代码。
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src\webapp 应用程序的客户端资源和设置。

app。应用程序的 JavaScript客户端代码。

css。用于定义应用程序图形用户界面的外观和格式的级联样式

表。common文件夹包含所有窗体因子的默认字体和 CSS。您可

以根据需要添加或修改所有窗体因子的样式表代码。要修改特定

窗体因子，请展开 desktop、smartphone或 tablet文件夹并根据需

要添加特定于窗体因子的样式表代码。

images。应用程序使用的参考图像。

每个 app、css和 images文件夹包含以下子文件夹：

l common。适用于所有窗体因子的内容。

l desktop。仅适用于台式电脑应用程序的内容。

l tablet。仅适用于平板电脑应用程序的内容。

l smartphone。仅适用于智能手机应用程序的内容。

descriptor.xml文件 (如上所述 )

WEB-INF。J2EE 容器的目录，包含 spring、 log4j和第三方日志记

录的标准 web.xml文件和资源。

app.js。包含应用程序的 JavaScript代码，其中包括 openEntryPoint
函数，此函数可指定用户打开应用程序时将打开的客户端位置。

有关详细信息，请参见 HP Anywhere API规范。

target 应用程序运行时创建的目标文件。创建应用程序项目时，此文件

夹为空。

准备好发布应用程序时，可将 <应用程序项目>\target\<应用程序

名称>-cp.zip文件提供给 HP Anywhere管理员，以将其部署到目

录。

minify.bat HP Anywhere IDE 用于缩小应用程序的批处理文件。

package.js 包含与缩小流程相关的应用程序信息。

pom.xml 包含常规应用程序数据，例如应用程序名称、版本和描述。

pom-
project.properties

包含常规应用程序数据，例如模板类型、端口、主机名和用户凭

据。
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附录 2：模板描述
HP Anywhere IDE提供启动程序项目，您可以将其用作您自己的应用程序项目的基础。

所有项目模板均包括所需的项目文件夹结构。My Report项目也包括代码，以供您用于

创建可与 REST API 进行通信并生成报告列表的应用程序。

模板 描述

Blank Project HP Anywhere启动程序项目，其项目文件夹结构中不包含应用程

序内容。

Hello World HP Anywhere启动程序项目，可结合使用本机框架与 JavaScript
和 HTML代码生成应用程序。

Hello World (Enyo) HP Anywhere启动程序项目，它使用 Enyo框架生成应用程序。

此项目面向平板电脑和智能手机使用。

Hello World (Jqm) HP Anywhere启动程序项目，它使用 jQuery Mobile框架生成应用

程序。此项目面向平板电脑和智能手机使用。

Hello World
(Sencha)

HP Anywhere启动程序项目，它使用 Sencha Touch框架生成应用

程序。此项目面向平板电脑和智能手机使用。

Hello World
(AngularJS)

HP Anywhere启动程序项目，它使用 AngularJS框架生成应用程

序。此项目面向平板电脑和智能手机使用。

My Report HP Anywhere启动程序项目，它结合本机框架以及 JavaScript和
HTML代码生成可显示报告列表的应用程序。

My Report (Enyo) HP Anywhere启动程序项目，它使用 Enyo框架生成可显示报告

列表的应用程序。此项目面向平板电脑和智能手机使用。

My Report (Jqm) HP Anywhere启动程序项目，它使用 jQuery Mobile框架生成可显

示报告列表的应用程序。此项目面向平板电脑和智能手机使

用。

My Report (Sencha) HP Anywhere启动程序项目，它使用 Sencha Touch框架生成可显

示报告列表的应用程序。此项目面向平板电脑和智能手机使

用。

My Report
(AngularJS)

HP Anywhere启动程序项目，它使用 AngularJS框架生成可显示

报告列表的应用程序。此项目面向平板电脑和智能手机使用。

Blank Project 模板

HP Anywhere启动程序项目，它包含标准的应用程序文件夹和文件，但是不包含任何特

定于应用程序的内容。有关文件夹和文件的详细信息，请参见附录 1：应用程序项目文

件夹结构 (第 38页 )。
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适用于本机应用程序的模板

Hello World是本机 HTML 5应用程序，在 HP Anywhere“我的应用程序 ”页面中显示 HP
Anywhere图标。除附录 1：应用程序项目文件夹结构 (第 38页 )中描述的标准文件夹和

文件之外，此项目还包括：

l src\webapp\app\common：此文件夹包含客户端 JavaScript、CCS和图像文件。代码

存储在 common文件夹中，以便对所有窗体因子可用。

l src\webapp\app\common\views：此文件夹包含：
n content.html：此应用程序的 HTML模板。

n MainView.js：可加载 JavaScript和 HTML 文件内容的初始视图。

n summary.html：在台式电脑窗体因子的 “我的应用程序 ”页面的  HelloWorld应用程序

卡中显示的内容。例如，卡通常包含应用程序名称、图标和可选内容，诸如文本

描述或概要、项列表或控制面板。

My Report是可显示报告列表的本机 HTML 5应用程序。除附录 1：应用程序项目文件夹

结构 (第 38页 )中描述的标准文件夹和文件之外，此项目还包括：

l src\webapp\app\common：此文件夹包含用于报告的客户端 JavaScript、CCS和图像

文件。代码存储在 common文件夹中，以便对所有窗体因子可用。

l src\webapp\app\common\views：此文件夹包含：
n content.html：此应用程序的 HTML模板。

n Content.js：用于从服务器检索报告所用的数据。

n MainView.js：可加载 JavaScript和 HTML 文件内容的初始视图。

n summary.html：在台式电脑窗体因子的 “我的应用程序 ”页面的  My Report Project应
用程序卡中显示的内容。例如，卡通常包含应用程序名称、图标和可选内容，诸

如文本描述或概要、项列表或控制面板。

适用于基于 Enyo的应用程序的模板

每个模板的设计符合基于 Enyo的应用程序的标准应用程序结构。HP Anywhere IDE 使用

Enyo加载程序初始化视图和呈现要显示的输出。

Hello World (Enyo)是基于 Enyo的应用程序，在 HP Anywhere“我的应用程序 ”页面中显示

HP Anywhere图标。除附录 1：应用程序项目文件夹结构 (第 38页 )中描述的标准文件夹

和文件之外，此项目还包括：

src\webapp\app.js：初始化 HelloWorld视图和呈现要显示的输出。这是控制器，包含此

应用程序后的逻辑。
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My Report (Enyo)是可显示报告列表的基于 Enyo的应用程序。除附录 1：应用程序项目

文件夹结构 (第 38页 )中描述的标准文件夹和文件之外，此项目还包括：

l src\java\com\hp\<项目名称>\...\rest：此文件夹包含用于检索报告列表的以下  REST 
服务类：
n ReportBean.java类：报告实体。

n ReportService.java类：REST 实现，其中包含嵌入的模拟数据。

l src\webapp\app\common：此文件夹包含报告应用程序客户端所需的 Enyo 资源，包

括：
n enyo：Enyo库代码。

n report：Report.js 和 ReportItem.js类，用于定义报告列表的显示方式。

l src\webapp\css\common：此文件夹包含适用于报告的特定于 Enyo的应用程序样

式。

l src\webapp\app.js：初始化报告视图和呈现要显示的输出。

适用于基于 Sencha Touch的应用程序的模板

每个模板结构的设计符合创建基于 Sencha Touch的应用程序的最佳实践，包括模型视

图控制。

Hello World (Sencha)是基于 Sencha Touch的应用程序，在 HP Anywhere“我的应用程序 ”
页面中显示 HP Anywhere图标。除附录 1：应用程序项目文件夹结构 (第 38页 )中描述的

标准文件夹和文件之外，此项目还包括：

l src\webapp\app\common：此文件夹包含应用程序客户端所需的 Sencha Touch资源，

包括 controller、data、mode、store和 view文件夹。这些资源存储在 common文件夹

中，以便对所有窗体因子可用。

My Report (Sencha)是可显示报告列表的基于 Sencha Touch的应用程序。除附录 1：应

用程序项目文件夹结构 (第 38页 )中描述的标准文件夹和文件之外，此项目还包括：

l src\java\com\hp\<项目名称>\...\rest：此文件夹包含用于检索报告列表的以下  REST 
服务类：
n ReportBean.java类：报告实体。

n ReportService.java类：REST 实现，其中包含嵌入的模拟数据。

l src\webapp\app\common：此文件夹包含报告应用程序客户端所需的 Sencha Touch 资
源，包括 controller、data、mode、store和 view文件夹。这些资源存储在 common文
件夹中，以便对所有窗体因子可用。
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适用于基于 jQuery Mobile的应用程序的模板

Hello World (JQM)是基于 jQuery Mobile的应用程序，在 HP Anywhere“我的应用程序 ”页面

中显示 HP Anywhere图标。除附录 1：应用程序项目文件夹结构 (第 38页 )中描述的标准

文件夹和文件之外，此项目还包括：

l src\webapp\app\common：此文件夹包含应用程序客户端所需的 JQM 资源，包括

conf、controller和 view文件夹。这些资源存储在 common文件夹中，以便对所有窗体

因子可用。

l src\webapp\libs\jqmobile：此文件夹包含应用程序的 JQM图像、CSS和函数。

l src\webapp\libs\jquery：此文件夹包含应用程序的 jQuery文件。

l src\webapp\libs\requirejs：此文件夹包含加载应用程序所需的资源。

My Report (JQM)是可显示报告列表的基于 jQuery Mobile的应用程序。除附录 1：应用程

序项目文件夹结构 (第 38页 )中描述的标准文件夹和文件之外，此项目还包括：

l src\webapp\app\common：此文件夹包含应用程序客户端所需的 JQM 资源，包括

conf、controller、models和 view文件夹。这些资源存储在 common文件夹中，以便对

所有窗体因子可用。

l src\webapp\libs\jqmobile：此文件夹包含应用程序的 JQM图像、CSS和函数。

l src\webapp\libs\jquery：此文件夹包含应用程序的 jQuery文件。

l src\webapp\libs\requirejs：此文件夹包含加载应用程序所需的资源。

适用于基于 AngularJS的应用程序的模板

每个模板结构的设计符合创建基于 AngularJS的应用程序的最佳实践。此结构仅包括附

录 1：应用程序项目文件夹结构 (第 38页 )中所述的标准文件夹和文件。没有唯一文件

或文件夹。
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附录 3：疑难解答
此部分描述了如何处理可能遇到的问题：

如何设置 Maven代理

如果通过代理连接到 Internet，则需配置 Maven代理以连接到 Maven存储库。如果尝试

创建应用程序项目，而不首先设置所需的代理，则会显示以下错误消息：

要配置 Maven 代理，请执行以下操作：

更新 %btoa_home%/apache-maven-3.0.4/conf/settings.xml中的 <代理>部分，并添加一

个代理。

例如：

<proxy>

    <id>MYNETPROXY</id>

    <active>true</active>

    <protocol>http</protocol>

    <host>myproxyhost.mydomain.com</host>

    <port>8080</port>

    <nonProxyHosts>*.devlab.ad</nonProxyHosts>

</proxy>

如何使用最新的 HP Anywhere插件更新 HP
Anywhere IDE

HP Anywhere插件定期更新。您可以在方便时下载和安装最新的 HP Anywhere插件。也

可以将 HP Anywhere IDE 配置为自动接收和下载 HP Anywhere插件的更新。
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要手动安装最新的 HP Anywhere插件并在将来接收自动更新通知，请执行以下操作：

1. 在 HP Anywhere IDE中，选择帮助 > Install New Software。此时将打开 “Available
Software”向导。

2. 在 Work with字段中，选择 HP Anywhere Eclipse Update Site。此向导屏幕中间的文

本区域将自动显示与 HP相关的复选框。

3. 选中 HP复选框。

4. 单击 Next并遵循向导的说明执行操作。

5. 出现提示时，重新启动 HP Anywhere IDE。

此过程将安装插件的最新版本并将 HP Anywhere IDE 配置为在将来有可用更新时自

动向您发送通知。

要在存在新插件可用更新时接收 /配置自动通知，请执行以下操作：

1. 选择 Window > Preferences > Install/Update > Automatic Updates。

2. 在 “Automatic Updates”窗格中，选中 Automatically find new updates and notify me复
选框。

3. 配置用于在存在可用插件更新时接收通知的计划和下载选项。

4. 单击确定。

从现在开始，发布插件更新时，您会接收到通知，允许在方便时安装插件的最新版

本。

要禁用在存在新插件可用更新时发送自动通知，请执行以下操作：

1. 选择 Window > Preferences > Install/Update > Automatic Updates。

2. 在 “Automatic Updates”窗格中，清除 Automatically find new updates and notify me复
选框。

3. 单击确定。

存在可用的新更新时，您将不会再收到通知。
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如何运行使用 HP Anywhere IDE 早期版本创建
的应用程序

在升级 HP Anywhere IDE之后，应用程序可能无法在更新版本上无缝运行，因为没有针

对最新的 HP Anywhere服务器版本编译应用程序：

要将应用程序升级到当前版本，请执行以下操作：

1. 在 HP Anywhere IDE Package Explorer中，导航到：<应用程序主节点>/pom.xml并双

击此文件打开它。

2. 在 “Design”或 “Source”选项卡中，将 btoa.build.version的值修改为最新版本，例

如：10.10.100

3. 运行此应用程序以重新编译它。

如果 getUserName方法 (UserInfoService API)
返回 NULL，该如何处理

1. 在 Package Explorer中，导航到：<应用程序主节点>/src/webapp/WEB-INF/Web.xml
并双击此文件打开它。

2. 将 <filter>部分替换为以下内容：

<filter>
<filter-name>DiamondTenantFilter</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>DiamondTenantFilter</filter-name>
<url-pattern>/rest/*</url-pattern>
<url-pattern>/services/*</url-pattern>

</filter-mapping>

<filter>
<filter-name>springSecurityFilterChain</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>springSecurityFilterChain</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
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<filter>
<filter-name>DiamondSecurityFilter</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>DiamondSecurityFilter</filter-name>
<url-pattern>/rest/*</url-pattern>
<url-pattern>/services/*</url-pattern>

</filter-mapping>
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